
FIRST . . . 

READ THE INSTRUCTIONS supplied by the meeting organizers! 

Having an idea about these details before you begin will make the whole process much 
easier. 

GENERAL FORMAT 

1. Determine the one essential concept you would like to get across to the 
audience.  

2. Re-read your abstract once again - are those statements still accurate? 
3. Determine the size of the poster (if you had read the instructions, you would 

already know this!). 
4. Determine if you have all the elements you'll need for the poster: Bits & 

pieces? Poster board, glue, razor blades, Bandaids . . . Data? Do you have 
the data you will need? How much time will you need to prepare the data for 
presentation (tables, photographs, etc.)? Outside agencies? Does material 
need to be sent out & returned (photographic services, collaborators)?  

�  A word of advice (the first of many; pick and choose what works for you). 
Preparing a poster will take as much time as you let it. Allocate your time wisely.  

• There are always things that go wrong, so do not wait until the last minute to 
do even a simple task.  

• This is a public presentation; by planning carefully, striving to be clear in what 
you say and how you say it, and assuming a professional attitude you will avoid 
making it a public spectacle.  

• If you have little experience making posters, it will take longer (estimate 1 
week at the very minimum).  

• Too much lead time, however, encourages endless fussing about. Do the poster 
to the best of your ability, then go do something else.  

SKETCH IT OUT! 

Make a sketch of the poster, using 4 inch x 6 inch cards:  

Arrange the contents in a series of 3, 4, or 5 columns. This will facilitate the flow of 

traffic past the poster:  
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Place the elements of the poster in position: 

 

• The title will appear across the top.  
• A brief introduction (3 - 5 sentences) will appear at the upper left.  
• The conclusions will appear at the lower right.  
• Methods and Results will fill the remaining space.  

THE TITLE BANNER 

 
This part of the poster includes the title of the work, the authors names, the 
institutional affiliations, and the poster number. 

THINK BIG! 

1. The title banner should be readable from 15 - 20 feet away.  
2. If space permits, use first names for authors to facilitate interactions.  
3. Middle initials and titles are seldom necessary, however.  
4. Use abbreviations where possible.  
5. City names, or even states, often may be dropped from the institutional 

affiliations.  
6. There are seldom rules regarding line justification of the title. Determine if you 

will left or center justify the text of the title banner once it has been formatted, 
based upon personal preferences and space constraints.  

7. Refer to your meeting guidelines for more details specific to the meeting you 
plan to attend.  

TITLE FONTS: 
Make it easy on your information-saturated audience.  

1. Use a simple, easy to read font. A san serif style, such as Helvetica (Mac) or 
Arial (IBM), is ideal.  

2. Use boldface and all-caps for the title itself.  
3. Use boldface and mixed upper/lower case for the authors names.  
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4. Use plain text, no boldface, and mixed upper/lower case for affiliations.  
5. Use boldface for the poster session number (the number you are assigned by 

the organizing committee).  

TITLE SIZES 
The most important parts of the title banner, the title itself and the poster session 
number, should be readable from about 25 feet away. Your title will lure viewers closer 
to see your imaginative and exciting study. The rest of the title, and the body of the 
poster, should be readable from about 10 feet away.  

1. The final size of letters in the title itself should be about 1.5 - 2 inches tall. That 
is about a 96 point size (or 48 points enlarged by 200% when printed.  

2. The authors names may be printed smaller, at 72 points (1 - 1.5 inches)  
3. Titles (Ph.D., M.D.) are usually omitted, although the meeting organizers may 

require that the presenting author, student authors, or society members be 
indicated.  

4. Affiliations can be even smaller, at about 36 - 48 points (0.5 - 0.75 inch)  
5. The poster session number should be printed separately, at about 96 point size. 

It typically is placed in the top of the title banner, to the left, right, or at the 
center.  

BANNER ASSEMBLY: 
A one-piece banner is easiest to carry, and some places have an in-house banner-
making service. Commercial firms may also offer this service.If you choose this route:  

• Call the banner service and ask for specific instructions regarding formatting 
and submission.  

• Proofread the banner. Several times.  
• Save it to disk. Then back it up onto another disk.  

An alternative is to use a printer and double-stick tape: 
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1. Set the printer output to landscape (wide) format, using A3 paper (you'll have 
fewer seams than if you use A4 paper).  

2. Print the title & lay it out on a table. Proofread it now, rather than after you 
have assembled it!  

3. Successive pages should overlap with only a small margin.  
4. Trim the overlap off one side of each page, and place a piece of double-stick 

tape in that position on the other page, then align the successive pages.  
5. This process is easier if you have included 2 thin, parallel lines across all pages 

of the banner, one above the text & one below. These lines will make it easier 
to align multiple pages. Once the banner is printed and put together, you can 
trim away the parallel lines with a straightedge & razor blade.  

Either method produces a title banner which should be about 4 - 8 inches tall, and 
which can be rolled into a compact cylinder for travel. Here are some hints if you'd like 
a more rigid banner, which won't curl when placed above your poster at the meeting. 

BEFORE YOU GO ANY FURTHER! 
Remember to make a backup copy of your poster.  

USE OF COLOR 
Mount poster materials on colored art, mat, or bristol board:  

1. Mat board is available in a large range of colors.  
2. Mat board is heavier, making it more difficult to crease the poster while 

traveling.  
3. Mat board has a more durable surface than other art papers.  
4. Mat boards is, however, heavier and more difficult to attach to display boards in 

the poster session.  

Use a colored background to unify your poster:  

1. Muted colors, or shades of gray, are best for the background. Use more intense 
colors as borders or for emphasis, but be conservative - overuse of color is 
distracting.  

2. Two to three related background colors (Methods, Data, Interpretation) will 
unify the poster.  

3. If necessary for emphasis, add a single additional color by mounting the figure 
on thinner poster board, or outlining the figure in colored tape.  

Color can enhance the hues or contrast of photographs:  

1. Use a light background with darker photos; a dark background with lighter 
photos.  

2. Use a neutral background (gray) to emphasize color in photos; a white 
background to reduce the impact of colored photos.  

3. Most poster sessions are held in halls lit with harsh fluorescent light. If exact 
colors are important to the data, balance those colors for use with fluorescent 
lighting. Also, all colors will be intensified; bright (saturated) colors may 
become unpleasent to view.  
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SEQUENCING CONTENTS 
The poster should use photos, figures, and tables to tell the story of the study. For 
clarity, it is important to present the information in a sequence which is easy to follow:  

1. Determine a logical sequence for the material you will be presenting.  
2. Organize that material into sections (Methods, Data/Results, Implications, 

Conclusions, etc.).  
3. Use numbers (Helvetica boldface, 36 - 48 points) to help sequence sections of 

the poster.  
4. Arrange the material into columns.  
5. The poster should not rely upon your verbal explanation to link together the 

various portions.  

EDIT RUTHLESSLY! 

There ALWAYS is too much text in a poster. 

1. Posters primarily are visual presentations; the text materials serve to support 
the graphic materials.  

2. Look critially at the layout. If there is about 20% text, 40% graphics and 40% 
empty space, you are doing well.  

3. When in doubt, rephrase that text or delete it. (Keep chanting this mantra: 
There always is too much text. Always too much text.) 

4. Use active voice when writing the text; It can be demonstrated becomes The 
data demonstrate.  

5. Delete all redundant references and filler phrases, such as see Figure ...  
6. Remove all material extraneous to the focal point of the poster.  
7. Since the abstract is usually published, there is no need to repeat it in the 

poster. The brief introduction should be sufficient to identify the purpose of the 
study.  

8. Since graphs & figures will have explanatory captions, there is no need to label 
the graphic with Figure 1, Table 2, etc.  

�  The poster is not a publication of record, so excessive detail about methods, or 
vast tables of data are not necessary. This material can be discussed with interested 
persons individually during or after the session, or presented in a handout. 

BEFORE YOU GO ANY FURTHER, SAVE & BACK UP YOUR WORK! 

ILLUSTRATIONS 

�  The success of a poster directly relates to the clarity of the illustrations and tables.  

• Self-explanatory graphics should dominate the poster.  
• A minimal amount of text materials should supplement the graphic materials.  
• Use regions of empty space between poster elements to differentiate and 

accentuate these elements.  
• Graphic materials should be visible easily from a minimum distance of 6 feet.  
• Restrained use of 2 - 3 colors for emphasis is valuable; overuse is not.  
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SHOW NO MERCY WHEN EDITING VISUAL MATERIALS! 
�  Once again, ruthless editing is very important.  
�  Visual distractions increase fatigue and reduce the probability of veiwers giving the 
poster a thorough read.  

• Restrained use of large type and/or colored text are the most effective means 
of emphasizing particular points.  

• Use short sentences, simple words, and bullets to illustrate discrete points.  
• Have the left edges of materials in a column aligned; center alignment 

produces ragged left & right edges. This makes reading the poster more 
difficult.  

• Avoid using jargon, acronyms, or unusual abbreviations.  
• Remove all non-essential information from graphs and tables (data curves not 

discussed by the poster; excess grid lines in tables)  
• Label data lines in graphs directly, using large type & color. Eliminate legends 

and keys.  
• Artful illustrations, luminous colors, or exquisite computer-rendered drawings 

do not substitute for CONTENT.  
• Lines in illustrations should be larger than normal. Use contrast and colors for 

emphasis.  
• Use colors to distinguish different data groups in graphs. Avoid using patterns 

or open bars in histograms.  
• Use borders about 0.5 inches all around each figures. Border colors can be used 

to link related presentations of data.  
• Colored transparency overlays are useful in comparing/contrasting graphic 

results  

PLAN AHEAD! 
�  You have probably heard this again and again. That is because it is IMPORTANT!  
�  With an increasing reliance placed upon poster presentations for information 
transfer at meetings, there comes an increased impatience with poorly presented 
materials.  
�  Although the poster preparation will expand to fill whatever time you allow it, don't 
be caught with an unfinished poster!  
�  Planning ahead is particularly important if photographs are to be used.  

• Allow time for at least two rounds of photographic processing to take place, 
just in case.  

• Custom photo processing may be more expensive, but offers rapid turn-around 
and precise color balancing.  

• Use sufficient enlargement to allow details to be seen at a distance of 6 feet or 
more.  

DOWN TO THE WIRE AND BEYOND 
�  Those who choose to live on the edge should note that:  

• Many larger meetings will have computers available for modifying posters. 
These facilities are, however, usually crowded.  

• There are always photo supply stores near the meeting which will sell you 
poster materials.  
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• If you are unfamiliar with the city, ask the hotel concierge for local businesses 
which might be able to help. Remember to tip!  

• Many hotels will have photocopy and Fax machines for guest use, and 
telecommunication ports in the hotel rooms.  

• The world of portable computers and the Internet offers interesting possibilities 
for a graceful recovery. Leave your poster on a server and you can access it 
from a remote site.  

• Before you leave for the trip, make a final backup copy & leave the disk in an 
obvious place. That way, you can have someone who has stayed behind print 
portions of the poster and fax then to you.  

POSTER TEXT 
Double-space all text, using left-justification; text with even left sides and jagged right 
sides is easiest to read. 
The text should be large enough to be read easily from at least 6 feet away.  

• Section headings (Introduction, Methods, etc.); use Helvetica, Boldface, 36 
point  

• Supporting text (Intro text, figure captions, etc.); use Helvetica, 24 point 
(boldface, if appropriate)  

• If you must include narrative details, keep them brief. They should be no 
smaller than 18 point in size, and printed in plain text. Remember that posters 
are not publications of record, and you can always come to the session armed 
with handouts.  

One option is to consider using a larger size (36 pt) for the Conclusion text, and a 
smaller size (18 pt) for Methods text. 
Attempt to fit blocks of text onto a single page:  

• This simplifies cutting and pasting when you assemle the poster.  
• For the same reason, consider using 11 x 14 inch paper in the landscape mode 

when printing text blocks on laser printers.  

Other options for fonts include Helvetica, Arial, Geneva, Times Roman, Palatino, 
Century Schoolbook, Courier, and Prestige. Note that these fonts represent a range of 
letter spacing and letter heights. Keep in mind that san serif fonts (having characters 
without curliques or other embellishments) are easiest to read. 
Finally, be consistent. Choose one font and then use it throughout the poster. Add 
emphasis by using boldface, underlining, or color; italics are difficult to read.  

PUTTING IT TOGETHER 
Great - you've got a good story, supported by bunches of data and lots of quality 
graphics. How do you go about making all this accessible to an audience, most of 
whom are suffering from information overload already (as well as too little sleep, 
convention food, and some of the worst coffee in the world)?  

THE POSTER'S BACKGROUND 
Two basic rules to keep in mind are that  

1) Artistry does not substitute for content 
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2) The fancier the poster, the greater the time investment. 

There are several common approaches.  

• Some folks use pieces of mat board (or Bristol board) to make a solid 
background for the entire poster. They may then choose to use a 
complementary color as a border for important elements of the poster. 

• Others use smaller pieces of board to frame only the elements of the poster, 
leaving spaces between the elements empty. 

Either approach works; the former gives a unified appearence and is easier to 
hang straight, while the latter is easier to carry to and from the meeting. It is 
also possible, but often expensive, to have a commercial house reproduce your 
completed poster as a single large sheet of paper, which can then be rolled into 
a cylinder for transport.  

The choice of a background (and complement) color is up to you. The general 
consensus, however, is that softer colors (pastels, greys) work best as a 
background - they are easiest to view for hours at a time, and offer the best 
contrast for text, graphic, and photographic elements. See the Use of Color 
section for some hints on choosing colors.  

Check with local suppliers, for color samples. Plan on using 2 - 3 large sheets of 
mat board per poster; plan on 3 sheets of board if you anticipate making a few 
errors. Next, measure the boards and cut them to size, then lay them out 
within your taped boundries. Once you've made these decisions, the next step 
is to begin trimming the elements of your poster.  

MEASURE TWICE, CUT ONCE 
Begin by measuring the elements of your first column - these bits are easier to replace 
if you make a mistake cutting them to size. Use a roller trimmer, sharp paper cutter, or 
straightedge and razor blade to carefully trim these pieces. Lay them out and move on 
to the next column.  

When you have finished cutting the text elements, adjust all the parts of the poster & 
step back to take a good look at it. If it appears crooked, it probably is. Trust your 
eyes and re-trim the offending piece.  

Before you trim those elements which are more difficult to replace (photographs, etc.), 
lay the poster out again and have someone else view it with you. NOW is the time to 
look for errors in the text and correct them. If you do make any changes in the 
text, save those changes!  

The next step is to actually assemble all the bits and pieces.  

ALMOST FINISHED - JUST STICK TO IT! 
This part is not too much different than applying adhesive when assembling the Title 
banner.  
First, wash your hands to remove any dirt or oils you may have acquired so far. Then, 
find a secluded and well-ventilated spot in which to work.  
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• Lay one section of the background out on a clean and dry surface. Place the 
corresponding poster elemnts in position. Use a T-square and soft-lead pencil 
to lightly mark the positions of each corner of the poster elements. 

• Put some scrap paper down on another surface to protect it, place a one of the 
poster elements face-down on the scrap paper, and apply adhesive. Place it in 
position on the background, then move to the next poster element and repeat. 
Clean your fingers often, to avoid sticky fingerprints on the poster - dust will 
stick & the prints will darken with time. Use absolute alcohol to dissolve & clean 
sticky spots, but be sure to test it in an inconspicuous spot first! Like the 
adhesives, some inks and paper dyes are soluble in alcohol. 

• Keep going until you finish, changing the scrap paper often. Use a gum eraser 
to rub out any obvious pencil marks. Then lay out the entire poster again, stand 
back (about 15 feet), and look for errors and mis-aligned bits. Change any 
problems now, before the adhesive sets!  

�  Even though you may be approaching your limits by this stage, remember to drink 
coffee or other beverages somewhere far away from the poster.  

MISCELLANEOUS COMMENTS 
�  This page contains comments applying to presentations and meetings in general, 
rather than to the details of poster assembly.  

• Since a poster is essentially a visual presentation, try to find ways to show what 
was done - use schematic diagrams, arrows, and other strategies to direct the 
visual attention of the viewer, rather than explaining it all using text alone.  

• Design the poster to address one central question. State the question clearly in 
the poster, then use your discussion time with individuals to expand or expound 
upon issues surrounding that central theme.  

• Provide an explicit take-home message.  
• Summarize implications and conclusions briefly, and in user-friendly language.  
• Give credit where it is due. Have an acknowledgements section, in smaller size 

type (14 - 18 point), where you acknowledge contributors and funding 
organizations.  

• Do not use school mascots or logos on the poster; they add a useless visual 
distraction to the poster, and indicate a degree of jingoism incompatible with 
scientific endeavors. 

• Vary the size and spacing of the poster sections to add visual interest, but do 
so in moderation.  

• Do not wander too far away from your poster during the session; be available 
for discussion!  

 

WISDOM OF THE AGES:  

• Remember to take the poster to the meeting when you leave home. This is a 
surprisingly stressful mistake, particularly if you plan to be on the job hunt at 
the meeting. Do not be the last one to leave for the meeting; know who is 
leaving after you, so they can bring the poster you left behind. 

• Do not entrust the poster to the tender mercies of baggage handlers. In 
addition to unintentional folds & creases, the poster may take a surprise trip 
around the world while you attend the meeting.  
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• It is worth repeating here - back up a copy of the poster to disk, and leave the 
disk in an obvious place. Someone staying behind may be willing to print a 
missing graphic and fax it to you, or work electronic magic and send you a copy 
of the poster over the InterNet. If all else fails, use a respected overnight 
courier service.  

• Hotel room double beds are a useful size for laying out posters. Do not, 
however, leave the poster materials on the bed if the hostel has zealous 
housekeeping staff. You can even use the bed for last minute poster assembly, 
but be forewarned - the residue of spray adhesive is less fun when sleeping 
than cracker crumbs.  

• Before you leave for the meeting, set the poster up and look at it critically. Is it 
all there? Are all the words in the title spelled properly?  

• While it is set up, use a push pin to make holes in the upper corners of each 
section of the poster components. Hanging the poster can be one of the more 
difficult and frustrating aspects of poster sessions, and this will to make 
hanging the poster a bit easier.  

• When you dismantle the poster, turn the introduction section over and make a 
pencil sketch of the assembled poster, numbering each section. Then write the 
numbers on the backs of the corresponding poster sections. Now someone else 
can hang your poster if you can not be there.  

• Use brown wrapping paper to bundle together the parts for each poster. This 
keeps it clean and, if you carry more than one poster with you to the meeting, 
the parts of different posters will not become mixed together.  

• Label the wrapped poster with your name, the hotel address & telephone 
number, your room number (especially if the room is not registered in your 
name), and the poster session number. A lost poster with a label like this may 
find its way back to you more quickly, maybe even in time for your session.  

• Take a roll of double-stick tape with you to the meeting, to re-attach any loose 
parts of the poster.  
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PowerPoint 

This is a tutorial for making a simple poster from beginning to end. If you 
have used Powerpoint, you can make a poster easily.  

1. Start PowerPoint: Make a New presentation – a blank one. When asked for a 
Layout, choose a blank one – one without anything – even a title.  

2. Choose the size of your poster by using the File menu/Page Setup. If rulers 
are not visible, you might want to enable them – use the View menu/Rulers.  
Banners: If your banner is less than 52.5 inches wide, it will obviously be 
much cheaper than one that is 56 inches which will not fit into the width of the 
paper. A long banner must be rotated and charged for the long direction. Just 
setup your slide for the size you want (like 8 by 52).  

3. Adding text: In order to add text, the text needs a "container" – a Text Box. 
Make a text box by  

1. Click on the Text Box tool or selecting Text Box under the Insert menu. 
(PowerPoint is very flexible in how its tools are arranged. The down side 
of that is that your tools may be in a different place than they are 
described here. The Text Box tool is often found near the bottom center 
– it looks like a mini page with an "A" in the upper-left part of it.)  

2. Click or click-and-drag where you want the text to be. After this second 
step, you should see the rectangular shape of the Text Box. You can re-
size it at any time by dragging one of the little square "handles". The 
box will also grow automatically as you type (if it needs to).  

As in many programs, you can change the font and size by highlighting the text 
to be changed and then making the changes. A 100-point font is about an inch 
high. If you don't see the size you want in the selection list, you can enter it in 
by hand.  

To move a Text Box, position your pointer over a part of the edge of the box 
that is not a handle. The pointer should become shaped like a plus sign with 
arrows. Click and drag the Text Box to the wanted position.  

You can change the color of the text, the edge, and the fill as well as other 
things under the Format menu/Text Box.  

Make a separate Text Box for each separate piece of text. "Separate text" 
means a portion of text that you want to be able to move independently from 
the others.  

4. Adding images: The two ways to add images are with Insert/Picture and with 
Copy and Paste:  

o Insert/Picture: This is the most common way of adding graphics to a 
PowerPoint document. If you have a file that is in one of several 
standard graphic formats (like JPEG, GIF, PICT, etc.), use the Insert 
menu/Picture/From-file and select your file. The image will appear on 
your document with handles. Use one of the corner handles to re-size it. 
(The corner handles will keep the same aspect ratio; the side handles 
will not.) Click and drag in the middle of the graphic to move it. You can 
do many other things to an image (including brightness, cropping, and 
resetting it to how it was originally brought in) under Format/Picture.  
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Image size: You need to plan ahead – in the package that created the 
graphic (or in program like PhotoShop) figure out the final print size of 
your graphic and scale it to about 150 dpi (dots per inch). The HP-3000 
prints at 600 dpi, but the dithering it needs to do for most colors (all 
except the seven colors RGB and CMYK) takes up space – anything over 
200 dpi is ignored for most colors. 150 dpi or even 100 dpi will look fine 
for most images.  

o Copy and Paste: Use this if you have something like an Excel graph you 
want to add to your document. Generally avoid this method if you can – 
Copy and Paste will often only give you a low-resolution copy of a 
graphic.  

o  
5. Background: You can select a background under the Format 

menu/Background. If you want a picture background, just use Insert/Picture 
and place it Behind everything else. Be careful of using too big of an image – 
large files can become combersome to work with.  

6. Lines, Boxes, Arrows: There are many other things that PowerPoint can do. 
Next to the Text Box tool are tools to make ovals, boxes, lines, arrows, etc. 
When you have made one of these, you can change it (when it is selected) with 
the Format menu/Colors and Lines.  

7. Zoom: You can control the zoom amount by clicking on the zoom choice box 
(if visible), or using the View menu/Zoom. This option only effects the screen 
view – not the printout.  
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HOW TO MAKE A GREAT POSTER  

by Dina F. Mandoli, University of Washington, Department of Botany, Box 355325, 
Seattle, Washington 98195-5325  

 

Making a great poster can be fun and is certainly a challenge! Here are some ideas 
about how to get the most attention for your efforts. 

I. A GREAT POSTER IS...  

readable,  

Readability is a measure of how easily the ideas flow from one item to the next. Text 
that has lots of grammatical problems, complex or passive sentence structure, and 
misspellings is "hard to read".  

legible,  

If a text is legible, it can be deciphered. For example, an old book may not be legible if 
the paper has corroded or the lettering has faded. A common error in poster 
presentations is use of fonts that are too small to be read from 6-10 feet away, a 
typical distance for reading a poster.  

well organized, and  

Spatial organization makes the difference between reaching 95% rather than just 5% 
of your audience: time spent hunting for the next idea or piece of data is time taken 
away from thinking about the science.  

succint.  

Studies show that you have only 11 seconds to grab and retain your audience's 
attention so make the punchline prominant and brief. Most of your audience is going to 
absorb only the punchline. Those who are directly involved in related research will seek 
you out anyway and chat with you at length so you can afford to leave out all the 
details and tell those who are really interested the "nitty gritty" later.  

 

II. TWO WAYS TO MAKE A POSTER ARE TO  

have someone else do it, or  

A professional illustrator will ask you about all the items in this presentation! Although 
they will execute the work, you are the final arbiter of the quality and content of the 
poster.  

make your own.  

Courtesy of Bencie Woll 

 



Designing the poster elements. Most posters are most quickly made using some kind of 
computer software. Printing the poster elements. There are many ways to make the 
elements or parts of your poster.  

III. TO BEGIN:  

decide what the main message is,  

Keep it short and sweet and make this your title! Use the active voice (i.e., avoid "ing" 
on the ends of verbs) and avoid the verb "to be" whenever possible.  

measure the space you have,  

Lay out the space physically as well as on paper to double check yourself. If you can, 
make the poster flexible enough to change the size by adding or omitting elements. 
This flexibility is handy if you are going to more than one meeting, if the poster boards 
are not exactly the size advertised, if the meetings have different in size requirements 
for posters, or if you wish to update your data between meetings.  

lay out your elements crudely,  

Before you actually spend time making the final elements of the poster, take pieces of 
paper that are about the right size and see if you can actually make it all fit. This will 
save you a lot of time in the long run.  

ELIMINATE all extraneous material,  

Given that the average poster gazer spends less than 10 minutes on your work and 
you have 11 seconds to trap your subject before they move on, only show data that 
adds to your central message. You do need a Title, Authors, Introduction, Results, and 
Conclusions. Some meetings require you to include the abstract also. Usually, omitting 
Materials & Methods is fine: most people will not read them anyway. If you wish, have 
a methods handout for those who ask for it. Although sometimes the method is 
essential to understand the data or the validity of the conclusions, most of the time, a 
short version here will do as well.  

begin to make individual components of the poster!  

 

IV. POSTER LAYOUT  

How to arrange poster elements and text within each panel.  

People approach new information in a known spatial sequence: we track vertically from 
center to top to bottom, and horizontally from left to right. This means that you should 
put the most important message in the center top position followed by the top left, top 
right, bottom left, and finish in the bottom right corner. That's why the poster title 
should be your punch line because, in that position, the title and your name will be 
seen in the first 11 seconds that a person looks at the poster.  
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The overall format of a good poster is dictated by the way we assimilate information. 
For example, you would never put your first panel on the right and ask your reader to 
proceed to the left because we are not trained to read that way. Newspaper format, 
two vertical columns that are arranged so that you read the left one first and then the 
right one, is highly "readable" since the reader does not spend time figuring out which 
panel to read next. A left to right horizontal rows arrangement works too but is not as 
common. You can easily walk around any meeting and find lots of variation.  

Space is important in a poster: without it, your reader has no visual pauses to think. 
Books leave space on the margins and by having chapters. Posters that are crammed 
with information are tiring to read and are seldom read in their entirety. Omit all 
extraneous text or visual distractions, including borders between related data and text, 
so the reader can assimilate your ideas easily.  

Size of poster elements or the fonts in each element can serve to emphasize the main 
points. For example, making your subheadings in all capitals and two font sizes larger 
than the rest of the text on the same panel will draw the reader's eye first, and so be 
emphasized. The use of multiple fonts in a poster can distract from the science.  

You will lend the most power to your words if you spatially arrange the text in each 
panel of your poster following the same principles used for the poster layout as a 
whole. A common street sign reads "go children slow". Because the word "children" is 
in capitals larger than the other words and is in the center of the image, you read 
"Children, go slow" even though that is not the actual spatial arrangement of the 
words in the sign. This sign is powerful, succinct, and highly readable.  

Practical matters.  

It takes time to make a great poster. Allow 2 to 3 days to assemble all the bits and 
pieces, such as photos or laser copies, and then 1.5 to 2 days to cut all the boards and 
assemble the poster physically. That last bit of data you rush around to get at the last 
moment will go completely unnoticed if your poster is messy and disorganized i.e. 
illegible and unreadable.  

It costs from £40 to £100 to make a poster depending on how you have it printed. 
Assembling your own poster on mounting boards is cheapest and one piece, color dye 
emulsion prints that you can roll up to transport are the most expensive.  

Portability is worth considering. The poster should fit into carry-on luggage so that 
even if your suitcase is lost, you can still present your work. If all your poster panels 
can stack and be packaged together, so much the better.  

A great poster is easy to assemble on site and can be flexible in assembly in case the 
poster space is smaller than advertised. If you cannot mount the poster by yourself or 
the poster is awkward for one person to mount on the materials provided, be sure you 
arrange for someone to help you. Often the person next to you will be glad to 
exchange labor. A map of how the poster should look when it is done is handy when 
you need to work quickly, are distracted or nervous.  

We recycle our poster boards by peeling off the old data and text and glueing on new 
material. Of course this means that you stick to the same style but it also saves time, 
money and trees.  
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Posters can be made in many styles. Roll-up single piece prints, individual boards, 
hinged boards that fold together all have their pluses. The style you chose is a matter 
of cost and personal taste.  

   

 

VI. FONT CHOICE:  

sizes,  

Font sizes need to be big to be effective. A good rule is to stand back from your own 
poster: if you, who are familiar with the material, cannot easily read it from 6 feet 
away, your audience will certainly not be able to.  

highlighting with text format,  

Indents set text apart and are great for short lists.  

Justification of text in the center of a line will draw attention.  

basic font choice and highlighting with font variations,  

Choose a basic font whose "e's" and "a's" stay open at all sizes and that is supported 
by your printer. Bookman, Helvetica, and Geneva are examples of good choices. If 
your font is not supported by the printer, you will get ragged edges on all your letters.  

Highlighting a few parts of the text is done easily with:  

/ capitals as in the "go CHILDREN slow" or the "Stop,..." street signs, 
/ Zapf dingbats instead of numbers for simple lists of things, 
/ wrapped letters that arc around an image, 
/ switch styles (bold, italics, shadow, etc.).  

   

 

V. COLOR  

ways to add color,  

Mounting boards are a fast way to add a color border to poster elements. Choosing a 
color that does not compete with your data is wise.  

LaserFoil is a new product that allows you to make your printed words from a laser 
printer come out in color. Available in mat, glossy, and "prism" finishes, LaserFoil can 
add pizzaz to a poster.  
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Colored graphic tape or dots, and white arrows (Chartpak, Lettraset) can be quickly 
applied to poster elements to draw attention to the elements you wish to.  

contrast,  

Proper contrast will reduce eye strain and make the poster more legible and interesting 
visually. Again, be careful that the color does not outclass the visual impact of your 
data: too much contrast is hard on the eyes and can distract the reader from your 
data.  

Adding light color backgrounds to your figures can make the poster attractive. For 
example, using white lettering and lines on a blue background can make your poster 
eyecatching. Like a painting, poster elements can also be double matted to add 
interesting contrast.  

fidelity of reproduction,  

Images do not stay the same between one medium and the next and this is especially 
true for color quality. Although it is efficient to use computer-generated color slides as 
poster elements, you lose some fidelity in doing so. For example, the edges of letters 
will blur slightly in going from a slide to a printed image or vice versa. Also, the colors 
you see on your monitor are usually not what comes out on the slide or on the final, 
printed poster element. You can "adjust" your monitor and check professional color 
books that show what the slide film recorders will print. However, it will not be an 
exact match from screen to print no matter what you do. Automatic film recorders 
used to print computer images also vary from model to model and from run to run just 
like photographic printing machines do. To keep the color "true", request custom 
printing. A good rule of thumb is to switch media as few times as possible.  

   

 

VI. FINAL CHECK BEFORE YOU ASSEMBLE THE POSTER  

Have some people look over your poster before you put it all together. If they are 
confused, it is far better to fix it now than to lose people at the meeting. Pay particular 
attention to things that may not be necessary: eliminate everything that you can!  

   

 

VII. POSTER ASSEMBLY  

It is trivial to assemble a poster once you have decided on and made all the individual 
elements. Be sure to give yourself enough time to assemble the poster. Keeping your 
hands and the work surfaces clean helps to produce a great looking poster.  

List of materials and tools needed.  
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individual poster elements (print 2 of each in case of goofs in gluing), 
mounting board  
colored paper panels about 1/4" larger than your poster elements that will be double 
borders around the data, 
adhesive, 
sharp knife, 
sharp paper cutter, 
ruler, 
soft pencil and rubber, 
T-square (optional but very handy)  
large surface covered with paper or newsprint to work on, 
clean paper and some tape to wrap the poster in for travel.  

I like to take a map of the final layout with me so that I don't make a mistake in 
putting the poster up. Some people number the backs of their poster elements. I 
always take my own tacks: I prefer the stainless steel 1/2" ones so I know the poster 
will stay up for the whole meeting and that I can actually get them into the poster 
board.  

Good luck and have fun making your poster and showing it. Displaying your finished 
work is a big accomplishment so take time to enjoy it and your interactions at the 
meeting. Remember that enthusiasm is contagious. Be on time and enthusiastic about 
showing your poster to colleagues at the assigned times during the meeting - it a fine 
chance to advertise yourself and your work!  
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Powerpoint Simple Instructions 
 

1. Open PowerPoint by double clicking on the PowerPoint Icon (easiest method).  

 2. Click on the New icon.   

 3. From the dialog box, select the blank slide. Then OK.  

4. Most people will find it easier to set up the poster in a smaller size slide and then 
enlarge the size just before printing. In some ways it's easier to lay everything out and 
then add information once you've seen where everything is to go.  

5. Be sure your ruler is available so you can see where you are adding text boxes. View 
| Ruler.  

6. Click on the text box. Insert the Title of your Presentation across the top of the 
slide. Add the author's names and affiliations. Your title should be quite large, not less 
than 12 points. You want people to be able to see your presentation title from a 
distance. (Remember, everything will be blown up when you enlarge your poster.)  

7. Now add some color. Click on the Font Color icon. Select the down arrow, then More 
Font Colors. Select the color you like, remembering that you want the title to be seen 
from a distance.  Remember that some color combinations will not work together; e.g., 
dark color on dark color. Be sure there is good contrast between the background and 
the print font.   

8. Lay out the sections of your paper. In our sample above, we decided to lay out the 
poster with the following sections: Introduction and Objectives, Population Studied, 
Methodology, A Graph, A Table, Discussions, Study conclusions and ideas for new 
research, and Funding Information. Use the Text Box in combination with the Line 
Style to create boxes. Key in the title of the section and use carriage returns to take 
you down to the bottom of the section. Put a line of xxxxxx to hold the bottom of the 
box in place.   

9. Once you have your boxes laid out you can start adding the real information to the 
text boxes. When you are all done, you can delete the line around the text boxes, add 
color to the headings and/or change the font size and type.   

10. Font sizes should be as follows:   
abstract - 5 point   
normal type - 8 font  
headings - 12 font  

When blown up to the correct full size, these fonts will be quite readable.   

Obviously, you will have trouble reading a 5 point font. Please remember that you can 
use the zoom feature to blow up the slide to 200 percent of its original size. That's 
usually enough to read the elements on the slide quite easily.   

11. To add an image, go to the Insert menu. Insert Picture | From File and find 
the file, then, OK.   
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Or, you can use Copy and Paste  (Select the graphic in the original document (you will 
see handles on the graphic), then Edit | Copy, click on the slide, then Edit | Paste.   

(No matter where you think the image is going to go, it will always be in the wrong 
place). Click on the image, hold the left mouse button down and drag the image where 
you want it to go. Then click on the image again, this time on one of the corners and 
either push in (to reduce the size of the image) or pull out, remembering to keep the 
left mouse button depressed.  

Backgrounds can be inserted by using the Format | Background command. Don't 
be heavy handed in your use of dark backgrounds. They use up a lot of ink and may 
overwhelm the viewer.   

Lines, boxes and arrows can be inserted using the Drawing Toolbar. If you don't 
see this Toolbar, use View | Toolbars | Drawing to make it available.  

12. To insert a table or graph from Excel, create the table or graph and highlight or 
select it in Excel. You can then click on Insert | Chart, or Insert | Object. Insert | 
Chart enables you to create a chart right in front of your eyes. Insert | Object enables 
you to add a finished chart and be able to link to it so that you can continue to update 
Excel and then when you open PowerPoint to update your Excel file, you'll see that it is 
already updated.  

13. To print the final version on a single piece of 11 x 8.5" paper to check it over 
before doing the final large size, go to File, Print, Slides, and click the check box to 
Scale to fit paper (only if you've blown it up to its final size). OK.   

14. If you want to see what the poster will look like in its final format, enlarge the page 
size. From the File menu, select Page Setup, then Custom from the Slides Sized 
For box. Select the height as 35 inches and the Width as 48 inches. Or select the 
Height as 56 inches, the longest length you can get. Be sure the slide is oriented 
Landscape. Then, OK.   

Instructions for Using an Existing Presentation as a Template  

1. Open the sample poster.    
2. Begin adding your information into the template as you delete the old information. 
Feel free to rearrange text boxes, or any graphs, lines, arrows and so on.  

Tricky Parts  

If you work in the tiny format, it can sometimes be a challenge changing font size 
below 8 points. To change a font size from 8 points to 5 points, go to Format | Font | 
Size | then key in 5 manually.   
 
Importing a PowerPoint Slide from another presentation  
Change the font size before you move it into the new presentation. Use this feature if 
you want to make your poster up out of existing PowerPoint slides. 
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